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CHAPTER  1

Introduction

This guide is for anyone reviewing or evaluating Citrix MetaFrame Presentation 
Server for Windows, Version 3.0.

Citrix MetaFrame Presentation Server is the easiest way to manage enterprise 
applications from a central location and access them from anywhere. As the 
foundation of the Citrix MetaFrame Access Suite, Citrix MetaFrame Presentation 
Server is the world's most widely deployed presentation server for centrally 
managing heterogeneous applications and delivering their functionality as a service 
to workers, wherever they may be.

MetaFrame Presentation Server is certified to run on Microsoft Windows 2000 
Server and Windows Server 2003, extending significantly the capabilities over and 
above that of Microsoft Terminal Services and supporting virtually any application. 
MetaFrame Presentation Server provides an exceptional foundation to build highly 
scalable, flexible, secure, manageable access solutions that reduce computing costs 
and increase the utility of any information system.
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MetaFrame Presentation Server Benefits
MetaFrame Presentation Server solutions enable you to provide your users with 
uninterrupted, secure access to your organization’s applications and information, 
from almost any device over any network connection−Internet, LAN, WAN, 
dialup, or wireless.

Whether your users rely on desktop PCs, Macintoshes, laptops, UNIX or Linux 
workstations, thin-client devices, Windows-based terminals, wireless devices, or 
other network appliances, you can use MetaFrame Presentation Server solutions to:

• Speed application deployment to thousands of users simultaneously

• Provide your mobile workforce with consistent access to mission-critical data 
and applications

• Quickly integrate remote offices with your corporate systems after an 
acquisition or expansion

• Enable fail-over systems for business continuity during an emergency or 
planned outage

Utilizing the MetaFrame Presentation Server, organizations can:

• Access any application on any device. Seamlessly access applications from 
any client platform including UNIX, Mac, Linux, DOS, Windows CE, and 
many others. 

• Web-enable existing applications. Provide browser-based access to virtually 
any application including Windows, UNIX, packaged, custom, and legacy 
applications without rewrites or specialized development.

• Simplify applications deployment. Rapidly publish new applications and 
upgrades to users across the enterprise without having to individually “touch” 
each desktop.

• Easily manage server farms from a single interface. Centrally manage 
servers, applications, licenses, printers, and users from any location.

• Leverage and extend existing investments in hardware and software. 
Deliver new generation applications, while protecting existing investments in 
hardware, networks, and applications.
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Introducing Citrix MetaFrame Access Suite
MetaFrame Access Suite powers the on-demand enterprise by giving workers, 
anywhere, at any time, using any device, over any connection, the ability to easily 
and securely access whatever resources they need without regard to the underlying 
computing complexity. The MetaFrame Access Suite offers integrated products that 
deliver:

• Device and network services

• Security and identity management services

• Aggregation and personalization services

• Presentation and conferencing services

• User provisioning/measurement and system management services

Previously, customers had to purchase these technologies separately and piece them 
together to build an architecture for enterprise access. In contrast, the MetaFrame 
Access Suite is a single, unified solution that provides secure, easy, instant access to 
managed enterprise resources, and simplifies the deployment and management of 
new applications in heterogeneous computing environments.

The following diagram illustrates the suite’s capabilities:

This diagram shows the products comprising MetaFrame Access Suite and how it 
provides an enterprise-wide secure access solution.

Download from Www.Somanuals.com. All Manuals Search And Download.



10 MetaFrame Presentation Server Reviewer’s Guide

Products in the MetaFrame Access Suite are fully integrated, making it easy to add 
and extend the value of your MetaFrame implementation.

For the latest product information about MetaFrame Access Suite, see 
ww.citrix.com/accesssuite.

Citrix MetaFrame Presentation Server for Windows. Provides the world's most widely 
deployed presentation server for centrally managing heterogeneous applications 
and delivering their functionality as a service to workers, wherever they may be.

For the latest product information about MetaFrame Presentation Server for 
Windows, see www.citrix.com/presentationserver.

Citrix MetaFrame Presentation Server for UNIX. Provides users with secure access to 
UNIX and Java applications, supporting Sun Solaris, HP-UX, and IBM AIX 
platforms.

For the latest product information about MetaFrame Presentation Server for UNIX, 
see www.citrix.com/presentationserverunix.

Citrix MetaFrame Secure Access Manager. Provides secure, single-point access over 
the Web to a wide range of internal and external information resources, including 
applications, data sources, documents, and Web content and services. With a 
powerful set of easy-to-use, wizard-driven configuration tools, IT administrators 
can enable browser-based access to the entire enterprise.

For the latest product information about MetaFrame Secure Access Manager, see 
www.citrix.com/secureaccessmanager.

Citrix MetaFrame Password Manager. Provides universal password security and 
single sign-on access to Windows, Web, proprietary, and host-based applications 
running within the MetaFrame environment.

Users authenticate once with a single password and MetaFrame Password Manager 
does the rest, automatically logging onto any password-protected information 
systems, enforcing password policies, monitoring all password-related events, and 
even automating end-user tasks.

For the latest product information about MetaFrame Password Manager, see 
www.citrix.com/passwordmanager.

Citrix MetaFrame Conferencing Manager. Adds to MetaFrame Presentation Server 
intuitive conferencing that eliminates geographical distances among team members, 
increases the productivity of meetings, and allows easy collaboration.

For the latest product information about MetaFrame Conferencing Manager, see 
www.citrix.com/conferencingmanager.

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 1 Introduction 11

MetaFrame Presentation Server Editions
To accommodate a wide spectrum of customer requirements for functionality and 
scale, MetaFrame Presentation Server is offered as three editions:

• MetaFrame Presentation Server, Standard Edition. Delivers the level of 
control that departments, workgroups, and small organizations need to extend 
the reach of Windows 2000 Server and Windows Server 2003 to any device. 
With the Standard Edition, small organizations can centralize IT management 
and provide workers with secure access to applications anytime, anywhere, and 
over any connection.

• MetaFrame Presentation Server, Advanced Edition. Builds on the features 
of the Standard Edition to provide additional scalability, manageability and 
application availability for growing organizations. The Advanced Edition is the 
ideal access infrastructure solution for small- to medium-sized organizations 
who need to effectively manage and deploy applications and scale as 
organizational needs require.

• MetaFrame Presentation Server, Enterprise Edition. Provides the ultimate 
access infrastructure solution for large organizations and multi-national 
corporations. The Enterprise Edition offers extensive scalability, rapid 
application deployment, and comprehensive monitoring capabilities needed in 
large server farms to manage access to Windows-based applications.

To provide a look at the broadest product functionality, MetaFrame Presentation 
Server, Enterprise Edition, has been selected for evaluation. This Reviewer's Guide 
provides a high-level overview of the MetaFrame Presentation Server solution, and 
describes the benefits of MetaFrame Presentation Server, Enterprise Edition.
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Introducing MetaFrame Presentation Server Components
MetaFrame Presentation Server includes the following components and 
component sets:

• MetaFrame Presentation Server

• Management Consoles
Presentation Server Console
Access Suite Console
License Management Console
Program Neighborhood Agent Console
Web Interface Console

• Administration Tools
ICA Administration Toolbar
Citrix Connection Configuration Tool
ICA Client Distribution Wizard
ICA Client Printer Configuration Tool
ICA Client Update Configuration Tool
Shadow Toolbar
SpeedScreen Latency Reduction Manager

• MetaFrame Presentation Server Clients
MetaFrame Presentation Server Client for 32-bit Windows (Program 
Neighborhood, Program Neighborhood Agent, and Web Client)
MetaFrame Presentation Server Client for Java
MetaFrame Presentation Server Client for 16-bit Windows
ICA Client for DOS (16- and 32-bit)
ICA Client for Linux
ICA Client for OS/2
ICA Client for Windows CE
ICA Client for Macintosh
ICA Client for UNIX
ICA Client for Nokia 9210

• Citrix Document Center

• Secure Gateway
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• Enterprise Edition Management Applications
Load Manager
Resource Manager
Installation Manager
Network Manager

The sections that follow describe each of these components and component sets.

MetaFrame Presentation Server
MetaFrame Presentation Server allows multiple users to log on and run applications 
in separate, protected sessions on a single or on multiple servers. You install 
MetaFrame Presentation Server on computers running a multiuser operating system 
and publish applications or other resources you want to make available to users. For 
example, using MetaFrame Presentation Server, you can make available office 
productivity applications (such as word processors and spreadsheets), enterprise 
resource planning applications such as SAP and Peoplesoft, or any other custom 
applications.

You can group a number of servers together to form a server farm. A server farm is 
a group of computers you manage as a single entity. Server farms provide you with 
a flexible and robust way of deploying applications and content to users.

Management Consoles
The following management consoles are available with MetaFrame Presentation 
Server.

• Presentation Server Console

• License Management Console

• Program Neighborhood Agent Console

• Web Interface Console

• Access Suite Console

Each of these consoles is described in the sections that follow.

MetaFrame Presentation Server Console
Presentation Server Console is the command center for the entire MetaFrame 
Presentation Server farm. It gives administrators single-point control of all system 
resources—servers, applications, licenses, printers, and users—for exceptional 
management power and simplicity.
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14 MetaFrame Presentation Server Reviewer’s Guide

You can use the Presentation Server Console to manage a server farm from any 
location. By default, the Presentation Server Console is installed with MetaFrame 
Presentation Server.

License Management Console
The License Management Console is a Web-based application that lets you track 
and manage licenses. Here are some examples of tasks you can perform with the 
License Management Console: 

• Track historical license usage 

• Track real-time license usage

• View alerts for when licenses are about to expire 

To access the License Management Console, you can use a Web browser from any 
location.

Program Neighborhood Agent Console
Program Neighborhood Agent Console is a Web browser-based tool designed to 
help you customize Program Neighborhood Agent for your users. Use Program 
Neighborhood Agent Console to set defaults for shortcuts, display size and colors, 
audio, logon method, authentication, and other functions. In addition, you can 
permit or deny users the ability to customize many of these options. Program 
Neighborhood Console is available from servers running the Web Interface. 

Web Interface Console
Use the Web Interface Console to monitor MetaFrame Presentation Servers from 
any workstation with a supported Web browser. Web Interface Console lets you 
view information about the server farm, published applications, servers, and active 
sessions, and lets you reset, disconnect, and shadow client sessions and send 
messages to users. Web Interface Console includes searching and filtering 
capabilitie.You can install the Web Interface Console on MetaFrame Presentation 
Servers running Internet Information Server 5.0.

MetaFrame Access Suite Console
The Access Suite Console is the management interface for the entire MetaFrame 
Access Suite.

You can use the Access Suite Console to manage multiple server farms from a 
central location. The Access Suite Console is designed to integrate with the 
Microsoft Management Console (MMC). The Access Suite Console snaps into the 
MMC to provide a central, easy to install, and easy to use location for managing 
your deployment. You can also access the Presentation Server Console from the 
Access Suite Console.
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Management functionality is provided through a number of snap-in management 
tools (extensions) that you can select when you install the Access Suite Console or 
at any time later. Extensions are available to help you: 

• View applications, servers, and zones in multiple farms

• Manage sessions across multiple farms

• Monitor the performance of your server farms

• Create reports analyzing your MetaFrame Presentation Server deployment

• Create a trace for problem analysis

Administration Tools
MetaFrame Presentation Server provides a number of administration tools. This 
section list included administration tools and provides a brief description of what 
they do.

ICA Administration Toolbar
The ICA Administration Toolbar provides easy desktop access to the following 
administration and management tools:

• ICA Client Update Configuration Tool

• Shadow Taskbar

• Citrix Connection Configuration Tool

• SpeedScreen Latency Reduction Manager

• Citrix SSL Relay Configuration Tool

• Presentation Server Console

• Access Suite Console

• Document Center

ICA Client Update Configuration Tool
To help organize automatic client updates, use the ICA Client Update Configuration 
utility to manage the client update database.

You can configure a client update database on each server in a server farm or 
configure one database to update the Clients for multiple servers running 
MetaFrame Presentation Server. As Citrix releases new versions of the Clients, you 
add them to the client update database.

Using the ICA Client Update Configuration Tool you can:

• Create a new update database
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• Specify a default update database

• Configure the properties of the database

• Configure client update options

• Add new Clients to the database

• Remove outdated or unnecessary Clients

• Change the properties of a Client in the database

Shadow Taskbar
You can use the Shadow Taskbar to shadow sessions and to switch among multiple 
shadowed sessions. Shadowing an ICA session means viewing the session from 
another session, usually running on another device. During shadowing, you can 
view and control other users’ sessions remotely.

Citrix Connection Configuration Tool
The Citrix Connection Configuration utility adds support for more connection types 
and advanced configuration options to the Terminal Services Configuration utility 
that ships with Windows.

Use the Citrix Connection Configuration utility to:

• Add network, asynchronous, and other types of connections

• Configure existing connections

• Set parameters for mapping client devices

• Set modem parameters

• Test modem configurations

SpeedScreen Latency Reduction Manager
SpeedScreen Latency Reduction Manager helps reduce a user’s perception of 
latency with mouse click feedback and local text echo. Use this tool to configure 
local text echo and other features that improve the user experience on slow 
networks.

Mouse click feedback, which is enabled by default, changes the appearance of the 
pointer from idle to busy after the user clicks a link, indicating that the system is 
processing the user’s request.

Local text echo temporarily utilizes client fonts to immediately display text a user 
types while the screen redraw from the server is in transit. When a user types text, 
the keystrokes are sent to the server, which renders the fonts and then returns the 
updated screen redraw to the client. You can bridge the delay between keystroke 
and screen redraw by enabling local text echo.
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Citrix SSL Relay Configuration Tool
Use the SSL Relay Configuration Tool to configure Citrix SSL Relay, which 
secures communication between a server running the Web Interface and your farm. 

Citrix SSL Relay provides end-to-end Secure Sockets Layer/Transport Layer 
Security (SSL/TLS) encryption between specific servers and clients. 

MetaFrame Presentation Server Clients
Citrix uses the Independent Computing Architecture (ICA) protocol to exchange 
information between a user’s client device and the published resources on the 
computer running MetaFrame Presentation Server. The MetaFrame Presentation 
Server Client software is available for a range of different devices so users can 
connect to published applications from various platforms.

This is a diagram showing multiple users of MetaFrame Presentation Server Clients on a 
variety of devices, which are connecting to a server farm and accessing published 
applications and resources.
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You publish any given application or content once on the server, but multiple users 
can simultaneously access the published resources. Application processing on the 
client is kept to a minimum because the application runs entirely on the server. The 
ICA protocol sends keystrokes, mouse clicks, and screen updates between the 
server and the client, so to the user of the client device it appears as if the software is 
running locally.

Because applications run on the server and not on the client device, users can 
connect from any platform. For example, Microsoft Outlook running as a published 
application looks and feels the same whether the user is connecting from a 
Windows CE hand-held computer, a Macintosh desktop, or a Linux workstation. 
You can control user connections to the server to prevent over-consumption of 
licenses or server resources.

With many clients (including the Clients for 32-bit Windows, Java, Macintosh, and 
Linux), you can secure ICA communications using the Secure Socket Layer (SSL) 
or Transport Layer Security (TLS) protocols. SSL/TLS provides server 
authentication, encryption of the data stream, and message integrity checks and 
enables you to securely deliver applications within a LAN or across the Internet.

Program Neighborhood
With the client Program Neighborhood, users can connect to published resources 
and servers running MetaFrame Presentation Server using:

• Application sets

• Custom ICA connections

An application set is a user’s view of the resources published on a given server farm 
that the user is authorized to access. Resources published in an application set are 
configured for such session properties as window size, number of colors, supported 
encryption levels, and audio compression rate. 

If these settings are not required to run the published application (such as, for 
example, the audio compression rate), you can change them on the client device at 
the application set level.

Program Neighborhood Agent
Using the Program Neighborhood Agent in conjunction with the Web Interface, 
you can integrate published resources with users’ desktops. Users access remote 
applications, desktops, and content by clicking icons on their Windows desktop, in 
the Start menu, in the Windows system tray, or any combination thereof.

The Program Neighborhood Agent handles the following functions:

• User authentication. The Client provides user credentials to the Web Interface 
when users try to connect and every time they launch published resources.
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• Application and content enumeration. The client presents users with their 
individual set of published resources.

• Application launching. The client is the local engine used to launch published 
applications.

• Desktop integration. The client integrates a user’s set of published resources 
with the user’s desktop.

• User preferences. The client validates and implements local user preferences.

The client Program Neighborhood Agent is designed for flexibility and ease of 
configuration.

Web Client
The Web Interface technology, which allows interactive applications to be 
published to users through a Web site, is built into MetaFrame Presentation Server. 

Use the Web Interface for MetaFrame Presentation Server to give users access to 
published resources through the Web or your Intranet. Users log on to the Web 
Interface using a familiar Web browser and see links to the applications that they 
are authorized to run.

The Web Interface Welcome page showing links for published applications and 
resources available in the server farm.
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The Web Interface dynamically creates an HTML page with a depiction of the 
server farm for each of your users. After logging on, each user sees a Web page that 
includes all the applications and resources in the server farm that you configure for 
that user. Using the Web Interface, you can create stand-alone Web sites for 
application access or Web sites that can be integrated into your corporate portal. 

Any enterprise that relies on the Internet for connectivity must contend with 
security issues. Despite the enthusiasm for worldwide business communications, 
corporations must still be assured that they can protect confidential data from 
prying eyes as it travels through a public network. You use the Web Interface with 
the Secure Gateway to transport data securely over the Internet, using standards-
based security technology. Users access their applications through the browser, 
typically as shown below.

The Secure Gateway for MetaFrame Presentation Server
Secure Gateway is an infrastructure component you use to secure access to server 
farms and access centers. The Secure Gateway transparently encrypts and 
authenticates all user connections to protect against data tampering and theft.

Install the Secure Gateway in a network’s demilitarized zone (DMZ) to form a 
secure perimeter around the MetaFrame Presentation Server components in your 
enterprise network. The Secure Gateway authenticates users connecting over the 
Internet and establishes a secure channel for data exchange between the client 
device and the MetaFrame Access Suite.

Extensible Solutions for Enterprise Systems
Many additional features are available as part of various MetaFrame Presentation 
Server solutions. You install and use only the features that you need on each server 
and customize the server according to your needs and the role of a server in your 
enterprise.

Many additional features are flexible because you can install them separately. You 
can administer the additional features that come with MetaFrame Presentation 
Server, Enterprise Edition, through the management consoles. This means that you 
use the same tools to access all of the information about computers running 
MetaFrame Presentation Server. For example, if you install the Enterprise Edition 
of MetaFrame Presentation Server, the management consoles include additional 
pages that you use to manage and monitor your server farm.
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Load Manager
Taking server farm load balancing to a new level, this component lets 
administrators customize rules to optimize server resources in any environment. 
Application scheduling permits administrators to schedule application availability 
to accommodate routine application and database maintenance. (Only available in 
MetaFrame Presentation Server Advanced and Enterprise Editions.)

Resource Manager
With this component, administrators can centrally monitor and manage the server 
farm to ensure continuous, smooth operation. Capabilities include real-time 
monitoring and alerting, application monitoring and usage, and user-configurable 
setting of metrics and alert thresholds. (Only available in MetaFrame Presentation 
Server Enterprise Edition.)

Installation Manager
This capability eases the administrative burden of installing and uninstalling 
applications on servers in large server farms. With the click of a mouse, 
administrators can replicate applications across the entire farm, saving time and 
effort. (Only available in MetaFrame Presentation Server Enterprise Edition.)

Network Manager
Enterprises that use network management software from leading providers, such as 
HP and Tivoli, can incorporate MetaFrame Presentation Server farms into these 
solutions and administer them through the native network management console or 
through a customized version of the management console. (Only available in 
MetaFrame Presentation Server Enterprise Edition.)

Citrix Document Center
The Citrix Document Center gives you a single point of access to all 
Administrator’s Guides for the MetaFrame Access Suite. Browse the Table of 
Contents for information about a task you want to accomplish and get point-and-
click access to all pertinent sections across the guides.
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New Features of MetaFrame Presentation Server 
The following new features and enhancements are included in this release. 

Simplified Licensing for MetaFrame Access 
Suite Products
New technology in MetaFrame Access Suite software simplifies managing your 
licensed products in the following ways:

• You centrally manage and monitor license usage

• You can access your licensing data remotely 

• You can create reports allowing you to analyze trends in license usage

• An electronic backup of all licenses is stored on the Citrix Web site

• You can share licenses across farms 

For more information about the license server, see “Licensing Evaluation Versions 
of Citrix Products” on page 37.

Enhanced Support for Large Farms
Zone data collectors now monitor server load information for their own zone 
instead of the entire farm. This behavior reduces traffic among zones when users 
connect to applications, especially in large farms where zones are connected across 
high latency links. 

In earlier releases, a data collector automatically sent updates about server loads in 
its zone to the data collectors in other zones. This change in communication is 
designed to reduce interzone network traffic. Instead of each data collector 
maintaining load information for all servers in the farm, the data collector maintains 
load information only for the servers in its own zone. This behavior is especially 
beneficial in large farms. 

Zone Preference and Failover
A new policy rule enables you to direct user connections to preferred zones and set 
transparent failover to backup zones when preferred servers are unavailable. When 
users open applications, the Zone Preference and Failover policy rule directs their 
connections to the server with the highest zone preference and lightest load. 

The Zone Preference and Failover rule is available if you are using the Enterprise 
Edition of MetaFrame Presentation Server. 

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 1 Introduction 23

Policies
You can now create policies to apply connection settings based on server groups, IP 
addresses, and client names—in addition to users or user groups as in earlier 
releases. New policy rules give you broader control over bandwidth limits, zone 
connection preferences, audio options, and printing. 

You can use new policy rules to do such things as: 

• Direct user connections to a local zone and set failover options to other zones 

• Route print jobs directly from the server to the printer rather than through the 
client device

• Control bandwidth limits for sessions 

• Control audio sound quality used by client devices 

The examples cited above include only a few of the new capabilities provided with 
connection policies.

Delegated Administration
With delegated administration, you can restrict an administrator’s permissions to 
perform certain tasks to select servers and applications. For example, you can:

1. Create two separate “session administrator” accounts.

2. Give one account permissions to manage user sessions on servers in California.

3. Give the other account permissions to manage user sessions on servers 
in Maine.

Bi-directional Audio Support
MetaFrame Presentation Server now supports client-side microphone input. This 
allows you to publish dictation software for use in client sessions. Using local 
microphones, including a number of Philips SpeechMike speech processing 
devices, users can record dictations with applications running on the server.

For example, a user away from the office can establish a client session to record 
notes using a laptop. Later in the day the user can retrieve the notes for review or 
transcription from the desktop device back at the office.

Download from Www.Somanuals.com. All Manuals Search And Download.



24 MetaFrame Presentation Server Reviewer’s Guide

Enhanced Multimedia Support
MetaFrame Presentation Server offers the following major multimedia 
enhancements.

SpeedScreen Multimedia Acceleration
SpeedScreen Multimedia Acceleration optimizes streaming multimedia playback 
through published instances of or remote desktop connections to Internet Explorer, 
Windows Media Player, and RealOne Player. This feature offers significant 
performance gains in the following areas:

• User Experience. Multimedia playback in ICA sessions is about as smooth as 
local playback

• Server CPU Utilization. The client device decompresses and renders 
multimedia content, freeing up server CPU utilization

• Network Bandwidth. Multimedia content is passed over the network in 
compressed form, reducing bandwidth consumption

SpeedScreen Flash Acceleration
SpeedScreen Flash Acceleration allows you to optimize the way MetaFrame 
Presentation Server renders and passes Macromedia Flash animations to users. 
Flash animations are a common component of many Web sites and Web 
applications.

SpeedScreen Image Acceleration
Using lossy image compression, SpeedScreen Image Acceleration offers you a 
trade-off between the quality of photographic image files as they appear on client 
devices and the amount of bandwidth the files consume on their way from server to 
client. Lossy image compression reduces the size of image files the server sends to 
the client by removing redundant or extraneous data from the files.
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Session Reliability
Session Reliability keeps ICA sessions active and on the user’s screen when 
network connectivity is interrupted. Users continue to see the application they are 
using until network connectivity resumes without prompting for users’ credentials 
again.

This feature is especially useful for mobile users with wireless connections. If a 
user with a wireless link enters a road or railroad tunnel and momentarily loses 
connectivity, the display on the client device freezes until connectivity resumes on 
the other side of the tunnel. The user continues to access the display during the 
interruption and can resume interaction with the application when the network 
connection is restored. 

Session Reliability is available and enabled by default with the Enterprise and 
Advanced Editions of MetaFrame Presentation Server. This feature is supported 
with Version 8 or later of the MetaFrame Presentation Server Client for 32-bit 
Windows.

Workspace Control
Workspace Control enables users to quickly switch between client devices and is 
especially useful to roaming or mobile users. You now have the ability to configure, 
and allow users to configure, the following controls on the Program Neighborhood 
Agent interface or the Web Interface: 

• Log on. You can configure user logon behavior to include automatically 
reconnecting to disconnected sessions only or reconnecting to disconnected and 
active sessions. 

• Disconnect. The new Disconnect command allows users to disconnect from all 
applications at once. 

• Reconnect. You can configure the Reconnect command to mean reconnecting 
to disconnected sessions only or reconnecting to disconnected and active 
sessions. 

• Log off. For the Web Interface, you can configure logoff behavior as logging off 
from the Web Interface and all active sessions together or logging off from the 
Web Interface only. 

Workspace Control is available if you are using the Advanced or Enterprise Edition 
of MetaFrame Presentation Server. For more information about Workspace Control, 
see “Workspace Control” on page 59.
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Other Key Features of MetaFrame Presentation Server
The following is a list of features that can only be found within MetaFrame 
Presentation Server:

Active Directory support. MetaFrame Presentation Server supports Microsoft 
Active Directory, allowing administrators to publish applications to Active 
Directory users and groups. Users can log onto MetaFrame Presentation Server 
using their full Active Directory-based username and password.

Printer management. Even in diverse printing environments, administrators can 
efficiently manage resources and ensure end-user satisfaction, thanks to tools 
enabling printer driver replication and client printer compatibility. Additionally, to 
maximize their personal productivity, end users can specify the amount of 
bandwidth that printing consumes—even over low-bandwidth connections.

Shadowing enhancements. Responding to stricter policies on observing 
employees, Citrix enables shadowing instances to be logged, and provides an on-
screen indicator when an administrator is shadowing a user. Shadowing is offered 
as an installation option to accommodate organizations whose policies prohibit user 
monitoring.

Client time zone support. In today’s distributed enterprises, users may be 
accessing MetaFrame Presentation Server from around the world. These 
applications run in the context of the user’s local time zone, ensuring accuracy of 
records and appointments. 

Expanded capacity. Citrix application serving environments can encompass 
hundreds of servers supporting tens of thousands of users—all within a single 
server farm.

Reduced IT administration. A central data store for all configuration settings lets 
administrators make changes more easily and efficiently. Managing hundreds of 
servers is accomplished smoothly, even with a limited IT staff.

Reduced network traffic. Citrix Independent Management Architecture (IMA), 
the foundation for MetaFrame Presentation Servers, reduces server-to-server 
communications. Configuration settings reside in the data store and are no longer 
broadcast to other servers, reducing bandwidth consumption on the corporate 
backbone.

Citrix administrator accounts. Previously, all Windows 2000 administrators had, 
by default, complete administration authority over MetaFrame 1.8 configurable 
settings. However, many organizations want to assign Citrix administration 
privileges to only certain designated Windows 2000 administrators. With 
MetaFrame Presentation Server, this is now a reality.
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Auto client reconnect. With the auto client reconnect feature, the Win32 and Java 
clients automatically reconnect to a session when they detect a dropped connection 
(when network issues occur outside of MetaFrame Presentation Server). Users can 
continue to work without reconnecting manually, reentering credentials, and 
restarting applications.

Content publishing. This feature lets you publish document files, media files, 
URLs, and any other type of file from any network location. Icons for published 
content appear in Program Neighborhood, on the desktop, and in the Web Interface. 
Users can double-click published content icons to access content in the same way 
they access published applications.

Connection control. This feature lets you set a limit on the number of connections 
that each user can have simultaneously in the server farm. You can also limit the 
number of concurrent connections to specified published applications, and you can 
prevent users from launching more than one instance of the same published 
application. (Available in Advanced and Enterprise editions.)

CPU prioritization. You can use the CPU prioritization feature to assign each 
published application in the server farm a priority level for CPU access. This 
feature can ensure that CPU-intensive applications in the server farm do not 
degrade performance of other applications. You can give a higher CPU priority to 
mission-critical published applications and a lower CPU priority to less-important 
applications. (Available in Advanced and Enterprise editions.)

Universal printing. Provides a single universal print driver for all printing needs. 
Universal printing eliminates the need to manage and maintain a large number of 
print divers while improving server stability and print quality. With universal 
printing, you can:

• Set printing preferences for autocreated printers, including paper size and copy 
count

• Refresh users’ printer settings each time they log on to an ICA session

• Choose to save or purge the print queue when users log out

• Configure published applications to launch without waiting for all printers to be 
created

NDS support. Support for Novell Directory Services allows users in Novell 
network environments using their NDS credentials to access published applications 
and content. 

SSL/TLS support for ICA. This feature enables use of the Secure Socket Layer 
(SSL) and Transport Layer Security (TLS) protocols to secure communication 
between ICA clients that support SSL/TLS and MetaFrame Presentation Servers. 
SSL/TLS provides server authentication, encryption of the data stream, and 
message integrity checks. After configuring the Citrix SSL Relay, you can specify 
the use of SSL or TLS when publishing applications. 
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ICA session monitoring. Performance counters let you use Windows Performance 
Monitor to observe ICA communication, including bandwidth and compression for 
sessions, servers, and individual virtual channels, and latency in ICA sessions. 
Performance monitoring can provide valuable information about utilization of 
network bandwidth and help determine if a bottleneck exists. (Available in 
Enterprise edition.)

Delegated administration. Citrix administrators can delegate to IT staff areas of 
server administration and farm management. Administrators can assign specialized 
staff members to perform specific farm management tasks, such as managing 
printers, published applications, or user policies. Members of the enterprise IT staff 
can carry out their assigned tasks without being granted full access to all areas of 
farm management. This release enhances the level of administration you can 
delegate. You can now create policies to apply settings based on users or user 
groups, server groups, IP addresses, or client names.

User-to-user shadowing. Users can shadow other users without requiring 
administrator rights. Multiple users from different locations can view presentations 
and training sessions, allowing one-to-many, many-to-one, and many-to-many 
online collaboration.

Smart card support. You can use smart cards with MetaFrame Presentation 
Server, supported clients, and the Web Interface to provide secure access to 
applications and data. Using smart cards simplifies the authentication process while 
enhancing logon security. MetaFrame Presentation Server supports smart card 
authentication to published applications, as well as to “smart card enabled” 
applications such as Microsoft Outlook.

Content redirection. Administrators can specify whether local or remote 
applications are used to open content, allowing for the appropriate application to be 
launched to better meet the needs of the user. With Content redirection, you gain 
flexibility when considering application installation and content storage locations.

Use Content redirection to redirect application launching from:

• Client to server. Content, such as a file attached to an email message, that the 
user encounters when running a local application is opened with an application 
published on the server. This capability is supported with the Win32 Program 
Neighborhood Agent, the Macintosh client, and the WinCE client.

• Server to client. URL links that the user encounters when running a session are 
opened using the locally installed Web browser. This capability is supported 
with the Win32 clients and the Linux client.

Policies. With policies, you can apply to specific users or user groups selected 
server settings, such as shadowing permission settings, printer autocreation settings, 
and client device mapping settings. Using policies, you can tailor your environment 
at the user level. User policy settings override all other MetaFrame Presentation 
Server and Terminal Services settings.
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Getting More Information and Help
This section describes how to get more information about MetaFrame Presentation 
Server and how to contact Citrix.

Accessing the Document Center
The Document Center provides a single point of access to the documentation and 
enables you to go straight to the section in the documentation that you need. It also 
includes:

• A list of common tasks and a link to each item of documentation.

• A search function that covers all the PDF guides. This is useful when you need 
to consult a number of different guides. 

• Cross-references among documents. You can move among documents as often 
as you need using the links to other guides and the links to the Document 
Center. 

You can access the Document Center from your product CD-ROM or install it on 
your servers.

To start the Document Center

• On a server on which you installed the Document Center, from the Start menu, 
choose All Programs > Citrix > MetaFrame Presentation Server > 
Documentation and open document_center.pdf.

• Or, from either the server or component CD, click Browse CD.
In the Windows Explorer window, open the Documentation folder, then open 
document_center.pdf.

Important To view, search, and print the PDF documentation, the Document 
Center requires Adobe Acrobat Reader 5.0.5 with Search or a later version with 
Search. You can download Adobe Acrobat Reader for free from Adobe Systems’ 
Web site, http://www.adobe.com/.
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Other Product Documentation
The documentation for MetaFrame Presentation Server includes online 
documentation, known issues information, integrated on-screen assistance, and 
application help. 

• Online documentation is provided as Adobe Portable Document Format (PDF) 
files. Online guides are provided that correspond to different features of 
MetaFrame Presentation Server. For example, information about the Web 
Interface is contained in the Web Interface Administrator’s Guide. Use the 
Document Center to access the complete set of online guides.

• Be sure to read the Readme.htm file in the \Documentation directory of the 
product CD before you install MetaFrame Presentation Server or when 
troubleshooting. This file contains important information that includes last-
minute documentation updates and corrections.

• In many places in the MetaFrame Presentation Server user interface, integrated 
on-screen assistance is available to help you complete tasks. For example, in the 
Access Suite Console, you can position your mouse over a setting to display 
help text that explains how to use that control.

• Online help is available in many components. You can access the online help 
from the Help menu or Help button.

Getting Service and Support
Citrix offers a variety of self-service, Web-based technical support tools from its 
Knowledge Center at http://support.citrix.com/. Knowledge Center features 
include:

• A knowledge base containing thousands of technical solutions to support your 
Citrix environment

• An online product documentation library

• Interactive support forums for every Citrix product

• Access to the latest hotfixes and service packs

• Security bulletins

• Online problem reporting and tracking (for customers with valid support 
contracts)

Another source of support, Citrix Preferred Support Services, provides a range of 
options that allows you to customize the level and type of support for your 
organization’s Citrix products.
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Subscription Advantage
Subscription Advantage gives you an easy way to stay current with the latest 
server-based software functionality and information. Not only do you get automatic 
delivery of feature releases, software upgrades, enhancements, and maintenance 
releases that become available during the term of your subscription, you also get 
priority access to important Citrix technology information. 

You can find more information on the Citrix Web site at 
http://www.citrix.com/services/ (select Subscription Advantage). You can also 
contact your Citrix sales representative or a member of the Citrix Solutions 
Network for more information.

Customizing MetaFrame Presentation Server
The Citrix Developer Network (CDN) is at http://www. citrix.com/cdn/. This open-
enrollment membership program provides access to developer toolkits, technical 
information, and test programs for software and hardware vendors, system 
integrators, ICA licensees, and corporate IT developers who incorporate Citrix 
computing solutions into their products.

Most of the operations that you can perform using the MetaFrame Presentation 
Server user interface can also be scripted by using the Citrix Software Development 
Kit (SDK). The SDK also lets programmers customize most aspects of MetaFrame 
Presentation Server. The Citrix Server Software Development Kit (SDK) is 
available from http://www.citrix.com/cdn/.

Education and Training
Citrix offers a variety of instructor-led training and Web-based training solutions. 
Instructor-led courses are offered through Citrix Authorized Learning Centers 
(CALCs). CALCs provide high-quality classroom learning using professional 
courseware developed by Citrix. Many of these courses lead to certification.

Web-based training courses are available through CALCs, resellers, and from the 
Citrix Web site.

Information about programs and courseware for Citrix training and certification is 
available from http://www.citrix.com/edu/.
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CHAPTER  2

Installing and Licensing MetaFrame 
Presentation Server Components

This chapter describes how to install and setup MetaFrame Presentation Server for 
Windows and its clients. Specifically, this chapter addresses:

• Requirements for Performing this Review

• Licensing Evaluation Versions of Citrix Products

• Installing MetaFrame Presentation Server and Creating a Server Farm

• Adding a MetaFrame Presentation Server to a Server Farm

• Installing MetaFrame Clients
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Requirements for Performing this Review
To perform this review, Citrix suggests that you have access to at least two clean, 
server-class computers that are not currently in use and a computer that can serve as 
a client device. All three computers communicate over a network and belong to a 
single domain or workgroup that is not currently used by a MetaFrame 
Presentation Server.

Suggested Hardware and Operating System Combinations
Citrix suggests that the two computers on which you install MetaFrame 
Presentation Server each have one of the following hardware and software 
combinations:

• Microsoft Windows 2000 Server or Windows 2000 Advanced Server

• Pentium-compatible processor, 166 MHz

• 256 MB RAM

• 2 GB hard disk with at least 1.25 GB available

• Microsoft Windows 2000 Data Center

• Eight-way array of Pentium III Xeon processors

• 256 MB RAM

• 2 GB hard disk with at least 1.25 GB available

• Microsoft Windows Server 2003, Standard Edition

• Pentium-compatible processor, 550 MHz

• 256 MB RAM

• 2 GB hard disk with at least 1.75 GB available

• Microsoft Windows Server 2003, Enterprise Edition

• Pentium-compatible processor, 733 MHz

• 256 MB RAM

• 2 GB hard disk with at least 1.75 GB available

• Microsoft Windows Server 2003, Datacenter Edition

• Pentium-compatible processor, 733 MHz

• 1 GB RAM

• 2 GB hard disk with at least 1.75 GB available
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Important Because the presence of MetaFrame Presentation Servers affect each 
other, we recommend that you isolate to their own subnet the MetaFrame 
Presentation Servers used in this review. 

Servers Running MetaFrame Presentation Server for Windows
The following are required by MetaFrame Presentation Server:

• Microsoft Internet Information Services (IIS) Version 5.0 or later and ASP.NET 
Please note the MetaFrame installer does not install IIS or ASP.NET. Prior to 
installing MetaFrame Presentation Server, use Manage Your Server to add to 
your server the Server Role Application server (IIS, ASP.NET).

• Terminal Services running in application mode
Please note that the MetaFrame installer does not install Terminal Services. 
Prior to installing MetaFrame Presentation Server, use Manage Your Server to 
add to your server the Server Role Terminal server.

• Microsoft .Net Framework, Version 1.1 or later, Visual J# .Net Version 1.1 or 
later, and Java Runtime Environment Version 1.4.1_02 or greater
Please note that if you do not have these components installed on your 
computer, upon your approval, the MetaFrame installer installs them. The 
MetaFrame Presentation Server CD also contains these installers in the 
installationSupport\JRE14102 folder.

Document Center Requirements
To view, search, and print the PDF documentation, you need Adobe Reader 5.0.5 or 
later with Search. You can download Adobe Reader for free from the Adobe 
Systems Web site.

MetaFrame Presentation Server Clients
The computer on which you are installing MetaFrame clients has the following 
system software requirements:

• Windows 9x, Windows 2000, Windows XP, Windows Me, or Windows NT 3.5 
or later

• Standard Web browser; Internet Explorer Version 4.0 or greater, or Netscape 
Navigator or Communicator Version 4.0 or greater
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MetaFrame Presentation Server Installation Overview
This section identifies MetaFrame Presentation Server components you are 
installing on each of your computers: your primary server, secondary server, and 
client computer.

On your primary server, you install the following:

• MetaFrame Access Suite License Server and License Management Console

• MetaFrame Access Suite Console

• MetaFrame Presentation Server and Presentation Server Console

• Web Interface

• Program Neighborhood Agent

On your secondary server, you install only MetaFrame Presentation Server.

On your client computer, you install the following:

• MetaFrame Web Interface Client

• MetaFrame Win32 Program Neighborhood Agent

The next section describes how to install the license server and license the 
evaluation versions of Citrix products.
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Licensing Evaluation Versions of Citrix Products
Because licensing is a crucial part of your product installation, Citrix recommends 
that you read this entire section before installing Citrix licensing or any Citrix 
products.

To license your MetaFrame Presentation Server product evaluation

1. Install MetaFrame Access Suite License Server and the License 
Management Console.

2. Use your license code to obtain your evaluation licenses from My Citrix, 
allocate them, and download your license file.

3. Use the License Manager Console to upload your license file.

These steps are described in detail in the sections that follow.

Installing MetaFrame Access Suite License Server and 
the License Management Console
MetaFrame Presentation Server requires the installation of MetaFrame Access 
Suite License Server. To install the license server and MetaFrame Presentation 
Server components, use the Server CD in your MetaFrame Presentation Server 
media pack.

To install the MetaFrame Access Suite License Server

1. Using a domain account that is also a member of the local Administrators 
group, log onto the computer on which you are installing MetaFrame Access 
Suite License Server.

2. Open the Server CD for MetaFrame Presentation Server.
If you do not see Citrix MetaFrame Presentation Server Setup, use Windows 
Explorer to open Autorun.exe on the Server CD.

3. On the Citrix MetaFrame Presentation Server Setup dialog box, click Product 
installations, then click Install MetaFrame Access Suite License Server.

4. On the License Agreement dialog box, choose I accept the license agreement, 
then click Next.

5. On the following dialog boxes accept the defaults by clicking Next:

• Prerequisites Installation

• Select Components

• Welcome
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6. On the License Agreement dialog box, choose I accept the license agreement, 
then click Next.

7. On the following dialog boxes, accept the defaults by clicking Next:

• Destination Folder

• Select Features

• License Files Location

8. On the Restart IIS Web Server Service dialog box, choose OK to restart IIS, 
then click Next.

9. On the Ready to Install Application dialog box, click Next, and after completion 
of license server installation, click Finish twice.

After installing MetaFrame Access Suite License Server, obtain and install your 
evaluation licenses. The next section describes how to obtain and install 
evaluation licenses.

Obtaining and Installing an Evaluation License
After you successfully install the license server and the License 
Management Console, obtain your evaluation licenses from Citrix.

Before obtaining your evaluation license, you may want to have the following 
information readily available: 

• Your My Citrix user ID and password

• Your license code that was provided to you by Citrix

• The name of the computer on which you installed your license server

After assembling this information, complete these basic steps for licensing 
MetaFrame Presentation Server:

1. Use your license code to activate licenses, generate a license file, and download 
it to the computer running the license server.

2. Use the License Management Console to upload the license file to your 
license server.

The sections that follow describe in detail each of these steps.
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To use MyCitrix to allocate licenses and download a license file

1. Using a Web browser and your MyCitrix user ID and password, log on to 
www.MyCitrix.com.

2. On the My Citrix page, open Licensing > Citrix Activation System > 
Activate Licenses.

3. On the Reseller Warning page, click I Agree.

4. On the License Activation page, type in your license code, then click Continue. 

5. On the Allocate Licenses page:

• Under Select Product, choose MetaFrame Presentation Server, 
Enterprise Edition.

• Select MetaFrame Presentation Server, and type 10.

• For Hostname of your Citrix License Server, type the name of your 
computer.

• Click Allocate.

6. On the Confirm your Selection page, verify the number of licenses you want to 
allocate is 10, click Confirm, then click Download License File.

7. On the File Download dialog box, click Save.

8. On the Save As dialog box, open My Computer > Local Disk > Program 
Files > Citrix > Licensing > MyFiles, then click Save.

After downloading the license file, you can close the Download Complete dialog 
box and Web browser window.

Next, you upload the license file to the license server. The next section describes 
how to use the License Management Console to upload the license file.
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To upload the license file to the license server:

1. Open Start > All Programs > Citrix > Management Consoles >License 
Management Console.

2. On the License Manager Console page, click Configure License Server.

3. On the Configuration tab, click Copy license file to this License Server. 

4. On the Upload License File page, click Browse, choose the license file you 
downloaded, then click Open.

5. On the Upload License File page, click Upload.

6. Click Current Usage and observe that you have installed your licenses.

7. Close the License Management Console.

Now that you have installed your license server and your evaluation licenses, you 
can install MetaFrame Presentation Server on your primary server and create your 
server farm. The next section describes how to install MetaFrame Presentation 
Server on your primary server.
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Installing MetaFrame Presentation Server and Creating a 
Server Farm

This section describes how to install MetaFrame Presentation Server on your 
primary server, which is how you begin building a server farm. In this 
demonstration, you install MetaFrame Presentation Server on the server on which 
you installed your License Server, and begin to build a server farm called 
DemoFarm.

In addition to the server farm, in this installation, you are also installing the Web 
Interface, which allows administrators to integrate and publish applications into any 
standard Web browser, without having to rewrite applications. On the client side, 
users benefit from the ease of using a familiar Web browser as their central interface 
to all published applications, as well as other application portal content, tools, and 
resources. On the server side, MetaFrame Presentation Server provides a single 
point of control, including the ability to publish applications from multiple server 
farms to a single Web page.

The MetaFrame installer installs the Web Interface on the server and places a single 
Web Interface site in the server’s Web document root directory. The Web site 
provides a fully functional example of the Web Interface and can be used as is with 
no additional configuration.

In preparation for creating DemoFarm

1. Using a domain account that is also a member of the local Administrators 
group, log onto the computer on which you installed MetaFrame Access Suite 
License Manager. This computer is your primary server.

2. On your primary server, ensure that you have installed and enabled:

• IIS and ASP.NET

• Terminal Services
You do this by adding the server roles of Application Server and 
Terminal Server, respectively.

3. Ensure you know the case sensitive spelling of the name of your primary server 
and the name of the domain to which it belongs.

4. Close all applications.

The next set of instructions describe how to install MetaFrame Presentation Server 
on your primary server.
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To begin installing MetaFrame Presentation Server on your primary server

1. Open the Server CD for MetaFrame Presentation Server.
If you do not see Citrix MetaFrame Presentation Server Setup, use Windows 
Explorer to open Autorun.exe on the Server CD.

2. Click Product installations, then click Install MetaFrame Presentation 
Server and its components.

3. On License Agreement dialog box, select I accept the license agreement, then 
click Next.

4. On the following dialog boxes, accept the defaults by clicking Next:

• Prerequisites Installation

• Select Components

• Warning screen

After performing the initial prerequisites installations, selecting components, and 
dismissing warnings, you install the Web Interface.

To install the Web Interface

1. On the Web Interface for MetaFrame Presentation Server Setup dialog box, 
click Next.

2. On the License Agreement dialog box, select I accept the license agreement, 
then click Next.

3. On the Connecting to a Server dialog box, in the Name field, allow localhost, 
then click Next.

4. On the following dialog boxes, accept the defaults by clicking Next:

• Clients

• Default Web Page

• Ready to Install Application

5. On the Web Interface for MetaFrame Presentation Server Setup dialog box, 
click Finish.

After installing the Web Interface, you create your server farm.
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To create your server farm

1. On the MetaFrame Presentation Server for Windows Setup dialog box, 
click Next.
On the License Agreement dialog box, select I accept the license agreement 
and click Next.
On the Product Edition Selection dialog box, verify selection of Enterprise 
Edition, then click Next.

2. From the Program Neighborhood drop-down, choose Entire feature will 
be unavailable.
From the Program Neighborhood Agent drop-down, choose Entire feature 
will be installed on local hard drive, then click Next.

3. On the Server Address for the Pass-Through Client dialog box, use localhost 
and click Next.
On the Pass-Through Authentication for the Pass-Through Client dialog box, 
choose Yes, then click Next.

4. On the Create or Join a Server Farm, verify selection of Create a new farm, 
and click Next.
In the Farm name field, type DemoFarm, and click Next, then on the In Assign 
Farm Administrator Credentials dialog box, click Next again.

5. On the Identify Citrix License Server dialog box, for Host name, type the name 
of your computer, then click Next. 

6. To accept the defaults on the Configure Shadowing and Configure Citrix XML 
Service Port dialog boxes, click Next twice.

7. Verify the selection of Add the list of users from the Users group now, 
deselect Add Anonymous users also, then click Next.

8. On the Review Your Selections dialog box, verify information, then 
click Finish.

9. On the Installer Information warning, click Yes.

10. On the Citrix MetaFrame Presentation Server for Windows Setup dialog box, 
deselect View the Readme file, then click Close.

After creating your server farm, install the MetaFrame Access Suite Console.
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To install the MetaFrame Access Suite Console

1. Bring the MetaFrame Access Suite Console Setup dialog box to the front and 
click Next.

2. On License Agreement dialog box, select I accept the license agreement, then 
click Next.

3. On the Destination Folder, Select Extension, and Ready to Install Application 
dialog boxes, click Next.

4. In MetaFrame Access Suite Console Setup, click Finish.

After installing the Access Suite Console, install the Presentation Server Console.

To install the Presentation Server Console

1. On the Management Console for MetaFrame Presentation Server 3.0 Setup 
dialog box, click Next.

2. On License Agreement dialog box, select I accept the license agreement, then 
click Next.

3. On the Ready to Install the Application dialog box, click Next.

4. On the Management Console for MetaFrame Presentation Server 3.0 Setup 
dialog box, click Finish.

After installing the console, install the Document Center.

To install the Document Center

1. On the Document Center Setup and Destination Folder dialog boxes, 
click Next.

2. On the Document Center Setup and Installation Summary dialog boxes, 
click Finish.

3. Restart your server.

In this section, you installed a primary MetaFrame Presentation Server and created 
a server farm called DemoFarm. In the next section, you set up a secondary server 
on another computer and add it to DemoFarm.
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Adding a MetaFrame Presentation Server to your Server Farm
This section provides instruction on how to install MetaFrame Presentation Server 
on a second computer and add it to an existing farm called DemoFarm. Your 
secondary server must be a computer other than one acting as your primary server 
and meet the prerequisites as described in the section “Requirements for 
Performing this Review” on page 34.

In preparation for adding a MetaFrame Presentation server to DemoFarm

1. Using an account that has full administrative privileges, log onto the computer 
you are going to use as your secondary server.

2. Ensure that you have added the server roles of Application Server and 
Terminal Server.

3. Ensure you know the case sensitive spelling of the name of your primary server 
and its domain.

4. Close all applications.

The next set of instructions involve running the MetaFrame installer on your 
secondary server in order to add it to DemoFarm.

To begin installing MetaFrame Presentation Server on your secondary server

1. Open the Server CD for MetaFrame Presentation Server.
If you do not see Citrix MetaFrame Presentation Server Setup, use Windows 
Explorer to open Autorun.exe on the Server CD.

2. Click Product installations, then click Install MetaFrame Presentation 
Server and its components.

3. On License Agreement dialog box, select I accept the license agreement, then 
click Next.

4. On the Prerequisites Installation dialog box, click Next.

5. In the drop-down boxes of these applications, choose Entire feature will 
be unavailable

• Web Interface 

• Access Suite Console

• Presentation Server Console

• Document Center
Then, click Next.

6. On the Warning dialog box, click Next.

After initializing the installation, add the server to your server farm.
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To add a server to your server farm

1. On the MetaFrame Presentation Server for Windows Setup dialog box, 
click Next.
On the License Agreement dialog box, select I accept the license agreement 
and click Next.
On the Product Edition Selection dialog box, verify selection of Enterprise 
Edition, then click Next.

2. In the drop-down boxes of these components, choose Entire feature will 
be unavailable:

• Management Console

• Installation Manager

• Program Neighborhood

• Program Neighborhood Agent

• WMI Providers
Then, click Next.

3. On the Create or Join a Server Farm dialog box, choose Join an existing farm, 
then click Next.

4. On the Join a Server Farm dialog box:

• Choose Connect to a database on this server.

• Replace ServerName with the computer name of your primary server.

• Click Next.

5. On Access the Database on a MetaFrame Presentation Server computer dialog 
box, provide:

• the domain user name that has administrative privileges on your primary 
server

• the domain user name password

• the domain name
Then click Next.

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 2 Installing and Licensing MetaFrame Presentation Server Components 47

6. Accept defaults on the following dialog boxes:

• On Identify Citrix License Server dialog box, verify selection of Use the 
global farm settings for the license server, then click Next.

• On the Citrix MetaFrame Presentation Server for Windows warning, 
confirm the use of farm settings, by clicking Yes.

• Accept the defaults on the Configure Shadowing and Configure Citrix XML 
Service Port dialog boxes, by clicking Next twice.

7. On the Add users to Remote Desktop Users group dialog box:

• Verify the selection of Add the list of users from the Users group now.

• Deselect Add Anonymous users also.

• Click Next.

8. On the Review Your Selections dialog box, verify information, then 
click Finish.

Finish your installation by completing the steps that follow.

To finish your installation

1. On the Installer Information warning, click Yes.

2. On the Citrix MetaFrame Presentation Server for Windows Setup dialog box, 
deselect View the Readme file, then click Close.

3. On the Installation Summary dialog box, click Finish.

4. Restart your server.

You now have a server farm, DemoFarm, which consists of two servers you can 
manage through the Presentation Server Management Console installed on your 
primary server.

The next section describes how to install Program Neighborhood Agent on your 
client computer, which enables access to applications published in your server farm.

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing MetaFrame Clients
This section describes how to install Program Neighborhood Agent on your 
client computer.

Before starting this installation, using a domain user name that is a member of the 
local Administrators group, log on to the client computer on which you are 
installing Program Neighborhood Agent.

To install Program Neighborhood Agent

1. Open the Citrix MetaFrame Components CD.
If you do not see Citrix MetaFrame Components setup, use Windows Explorer 
to open Autorun.exe on the Components CD.

2. On the Citrix MetaFrame Components dialog box, click MetaFrame 
Presentation Server Clients, then Install MetaFrame Presentation Server 
Client for Windows.
On the MetaFrame Presentation Server Client Setup dialog box, click Next.
On the License Agreement dialog box, select I accept the license agreement, 
then click Next.

3. On the Select Client dialog box, pull down the Program Neighborhood menu, 
choose Entire feature will be unavailable, then click Next.

4. On the Server Address dialog box, type the URL of your primary MetaFrame 
Presentation Server.
The URL of your primary server has the following form:

http://servername
where servername is the name of your primary server.

5. On the Select Program Folder and Client Name dialog boxes, accept the 
defaults by clicking Next.

6. On the Use Local Name and Password dialog box, select Yes, then click Next.

7. On the Ready to install dialog box, click Next.

8. On the MetaFrame Presentation Server Client Setup dialog box, click Finish.

9. Restart your client computer.

You have now installed Citrix Program Agent on your client computer. However, 
before you can use Program Neighborhood Agent to access applications on your 
servers running MetaFrame Presentation Server, you must publish applications in 
your server farm, DemoFarm.
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The next chapter describes how to:

• Use the MetaFrame Presentation Server Management Console to publish 
applications

• Use the Web Interface and Program Neighborhood Agent to access 
published applications

• Use the Management Console to manage your servers
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CHAPTER  3

Using MetaFrame Presentation 
Server for Windows

This section describes how to demonstrate the features and capabilities of 
MetaFrame Presentation Server. It contains the following information:

• Using the management console

• Publishing applications and content

• Creating application Web sites with the Web Interface

• Running published applications

• Accessing published content

• Managing ICA sessions

• Managing printers for ICA clients

• Using universal printing capabilities

• Creating policies
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Using the Presentation Server Console
The Presentation Server Console is a comprehensive, graphical interface that 
centralizes the management of your entire server farm, including servers, 
applications, licenses, printers, and users. The console is a Java-based, 
extensible program. 

To run the Presentation Server Console

1. On your primary MetaFrame Presentation Server, from the Start menu, choose 
All Programs > Citrix > Management Consoles > Presentation 
Server Console.

2. In Log On to Server Farm, enter your domain user name, password, and domain 
for the farm administrator you created during MetaFrame Presentation 
Server setup, then click OK

From the console, you can:

• Publish and manage applications on any server in your server farm

• Manage MetaFrame administrators

• Manage client installations and upgrades

• Monitor server loads

• Manage policies for controlling user access

• Manage printers

• Monitor resource usage of a server farm

• Manage a server farm or individual servers
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This screen capture shows the Presentation Server Console for DemoFarm.

The console window is split into two panes:

1. The left pane shows the components of a server farm. The object at the top of 
the tree represents the server farm. The next level of objects under the server 
farm represents management features and components in the server farm, called 
nodes.

2. The right pane shows information about the object selected in the left pane, 
displayed in tabs. The tabs that are available in the right pane depend on the 
object selected in the console tree.
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Making Published Applications and Content Available to Users
This section describes how to perform the following tasks:

1. Publish Notepad from the primary server of DemoFarm.

2. Publish Calculator from the secondary server of DemoFarm.

3. Publish a link to My Citrix.

4. Make DemoFarm available to users in your domain.

Publishing Applications
When you have installed the applications you want to publish on a server in the 
farm, you publish them for your end users to access. You can use the Presentation 
Server Console to publish applications on any server in the server farm; you do not 
have to run the console from the server on which you installed the applications.

To publish Notepad from your primary server

1. From the console, under DemoFarm, select Applications and from the Actions 
menu choose New > Published Application.

2. In Publish Application, for Display Name, type Notepad1, then click Next.

3. In Specify What to Publish:

• Under Application Type, choose Application.

• For Command Line, type C: \WINDOWS \system32\notepad.exe, then 
click Next.

4. In Program Neighborhood Settings, under Application Shortcut Placement, 
select Add shortcut to the client’s desktop, then click Next.

5. In Specify Application Appearance, uncheck Maximize application at 
startup, then click Next.

6. In Specify Client Requirements, click Next.

7. In Specify Application Limits, click Next.

8. In the Specify Servers, select your primary server, click Add, then click Next. 
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9. In Specify Users:

• Double-click the domain in which your server resides.

Note Please do not choose your computer name. Choose the domain of the user 
name you used to log in.

• Choose Domain Users and click Add.

• Click Next.

10. In Specify File Type Associations, click Finish.

You have now published Notepad from the primary server of DemoFarm. Domain 
users who connect to DemoFarm can run Notepad from your primary server.

To publish Calculator from your secondary server

1. In the Management Console on your primary Presentation Server, under 
DemoFarm, select Applications, then from the Actions menu, choose New > 
Published Application.

2. In Publish Application, for Display Name, type Calculator2, then click Next.

3. In Specify What to Publish:

• Under Application Type, choose Application.

• For Command Line, type C: \WINDOWS \system32\calc.exe, then 
click Next.

4. In Program Neighborhood Settings, under Application Shortcut Placement, 
choose Add shortcut to the client’s desktop, then click Next.

5. In Specify Application Appearance, deselect Maximize application at startup, 
then click Next.

6. In Specify Client Requirements, click Next.

7. In Specify Application Limits, click Next.

8. In the Specify Servers, select your secondary server, click Add, then click Next. 

9. In Specify Users:

• Double-click the domain in which your server resides.

• Choose Domain Users and click Add.

• Click Next.

10. In Specify File Type Associations, click Finish.

Download from Www.Somanuals.com. All Manuals Search And Download.



56 MetaFrame Presentation Server Reviewer’s Guide

You have now published Calculator from the secondary server of DemoFarm. 
Domain users who connect to DemoFarm can transparently run Calculator on your 
secondary server.

Publishing Web Content
You can give users access to information, such as documents, Web sites, and video 
presentations, by publishing content for users in the same way that you 
publish applications.

With content publishing, you can publish and manage various types of content and 
present it to users with the applications they need. Published content and published 
applications appear together through the Web Interface, Program Neighborhood, 
and Program Neighborhood Agent interfaces.

You can configure MetaFrame Presentation Server to allow users to open published 
content in local player or viewer applications running on client devices or in 
published applications.

To publish the My Citrix Web page

1. From the Actions menu in the management console, choose New > 
Published Application.

2. In Publish Application, for Display Name, type My Citrix, then click Next.

3. In Specify What to Publish, choose Content. For Content Address, type 
http:\\www.mycitrix.com, then click Next.

4. In Program Neighborhood Settings, select Add shortcut to the 
client’s desktop, then click Next.

5. In Specify Users, double-click the domain in which your server resides, choose 
Domain Users and click Add, then click Finish.

After publishing applications and content, configure the Web Interface. The next 
section explains how to open the Web Interface Console and configure the Web 
Interface for use with DemoFarm.
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Configuring the Web Interface
To manage the Web Interface, using the correct credentials and a device that 
supports a Web browser, access the Web Interface Console.

To access the Web Interface Console

1. On your client computer, open a Web browser and in the Address field, type 
the following:

http://<servername>/Citrix/MetaFrame/WIAdmin

where <servername> is the name of the server running the Web Interface.

2. Enter your domain user name and password, then click OK.

3. In the left pane, under Server Settings, click Manage Farms.

4. In Manage MetaFrame Server Farms:

• For Farm Name, type DemoFarm, and click Add.

• Select Farm1, click Delete, then click Save.

You can now use the Web Interface Console to manage user access to DemoFarm 
through the Web Interface.

For more information concerning the features of Web Interface Console, click Help 
in the Web Interface Console or see the Web Interface for MetaFrame Presentation 
Server Administrator’s Guide, which is available from the Document Center.

Now that you have configured the Web Interface, you can test MetaFrame 
Presentation Server abilities by using MetaFrame client features. The next section 
describes a typical MetaFrame client experience.
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Exploring the User Experience
This demonstration shows how to access applications and content published in the 
previous sections. This section describes:

• Using a Web browser to access applications on a client

• Accessing published applications and content from the desktop of your 
client computer

• How Workspace Control makes application data available for roaming users

Running Published Applications Through a Web Browser
Using a Web browser on your secondary server, this demonstration shows how you 
can use the Web Interface to access published applications.

To access published applications through the Web Interface

1. Use a Web browser to open the URL to your primary server, which runs the 
Web Interface. The URL to your primary server has the following form:
http://servername
where servername is the name of your primary server in DemoFarm. In this 
demonstration, your primary server is also hosting the Web Interface.

2. Enter your domain user name, password, and domain name, then click Log In.
In the Web Interface note that Calculator2, My Citrix, and Notepad1 are all 
available.

3. Click Notepad1.

4. If Client File Security pops up, ensure the selection of No Access and Always 
ask me, then click OK.

5. Type some text in a Notepad document and leave the document open.

6. Click Calculator2. Use Calculator’s keypad to enter some numbers and leave 
Calculator open.

7. Click My Citrix, and note that My Citrix opens in a local browser window.

8. Leave all these applications running on your secondary server and log into your 
client computer.
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Running Published Applications from a Client Desktop
After rebooting your client computer, you can access published applications from 
the desktop.

After logging into your client computer note that you have three icons on your 
desktop: Calculator2, which runs calculator on the secondary server of DemoFarm, 
Notepad1, which runs Notepad on the primary server of DemoFarm, and My Citrix, 
which opens www.mycitrix.com in a browser window that runs locally.

To show that you can run applications from DemoFarm

1. Double-click Calculator2 on the desktop.

2. Double-click Notepad1 on the desktop.

Note that both applications appear to be running locally, but are actually running on 
the servers in your MetaFrame Server farm, DemoFarm.

Workspace Control
In addition to both applications appearing to be running locally, note that text you 
earlier typed in Notepad and the numbers you earlier typed in Calculator are 
available. This is called Workspace Control and is a feature that is new with 
MetaFrame Presentation Server.

Workspace Control provides users with the ability to quickly disconnect from all 
running applications, reconnect to applications, or log off from all running 
applications. You can move between client devices and gain access to all of your 
applications when you log on. For example, health care workers in a hospital can 
move quickly between workstations and access the same set of applications each 
time they log on to MetaFrame Presentation Server. These users can disconnect 
from multiple applications at one client device and open all the same applications 
when they reconnect at a different client device.

Printing to Client Printers
When client users run applications that are published on servers, they can print to 
the following types of printers:

• Printers connected to client devices running Windows, Windows CE, DOS, 
or MacOS

• Virtual printers created for tasks such as printing from a PostScript driver to 
a file

• Shared printers that are connected to print servers on a network

• Printers that are directly connected to the servers
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For the clients for 32-bit Windows, any printer that is set up in Windows on the 
client device is a client printer. Locally connected printers, printers that are 
connected on a network, and virtual printers are all client printers.

To test printing from a client

1. Return to your client computer where Notepad is running.

2. In Notepad, choose File > Print. Your text is printed on the printer connected to 
the client computer.

In order to demonstrate the administrative capabilities of MetaFrame Presentation 
Server, please leave Notepad and Calculator running on your client computer.

Monitoring and Managing Client Sessions
In this section, you will use the management console to view the sessions running in 
the server farm.

The management console provides centralized management of your users’ client 
sessions. You can use the console to:

• Monitor client sessions–viewed by server or published application

• Send messages to users in active sessions

• Reset or disconnect sessions and log off users

• Monitor and remotely control selected sessions using the shadowing feature

To view session information for a server

1. Return to your primary server, which is where you have installed the 
Presentation Server Console.

2. If the management console is not open, open Start > All Programs > Citrix > 
MetaFrame Presentation Server > Presentation Server Console, and log on.

3. In the left pane of the console, expand the Server tree and select the 
primary server. 

4. In the right pane click the Sessions tab, and note the column Application 
displays Notepad1.

5. In the left pane, under Servers, select the secondary server. 
Note the Application column now displays Calculator2, which is running on 
your secondary server, and is being managed from your primary MetaFrame 
server, but appears on your client computer.
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Managing Printers for Clients
The Presentation Server Console provides access to all printer management 
features. Below are some key points for managing printers in a farm:

• You can make printers that are already installed on client computers available in 
ICA sessions. To do so, install printer drivers on a server and use the replication 
feature in the management console to distribute the drivers to all servers in the 
farm. MetaFrame Presentation Server autocreates these client printers in ICA 

• You import network print servers into the server farm to make the shared 
printers available to all users when they connect to servers in the farm.

• If some client printer drivers are not compatible with the server platforms in the 
farm, use the Driver Compatibility feature to prevent incompatible printer 
drivers from causing server errors.

• When users print from applications running on servers, the installed client 
printers are displayed in Windows in the following form:

#clientname/printername
where clientname is the name of the client machine, and printername is the 
name for the printing device installed on the client. 

• When users print to the network printers in the server farm, they see the original 
assigned network printer names in Windows dialog boxes.
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Configuring Auto Creation of Client Printers
You configure auto creation settings differently for client printers that are not on 
DOS and WinCE platforms using the management console for MetaFrame 
Presentation Server. Select Printers in the left pane of Printer Management 
Properties and choose the Auto-Create Client Printers when user logs on option to 
allow client printers to be automatically created when users log on to ICA sessions. 
This option is selected by default. If you do not select this option, client printers are 
not automatically created although users can set up connections to client printers 
manually.

When you select Auto-Create Client Printers when user logs, you can configure 
how the printers work using the following options:

Update printer properties at each logon. Select this option to update client printers 
on the server using settings from printers on the clients. The client printers are 
updated when users log on. Do not select this option if you want to retain changes to 
client printers on the server made during ICA sessions.

Inherit client printer's setting for keeping printed documents. Select this option to use 
the client printer setting Keep printed documents on auto created client printers. 
The setting determines if printed jobs are saved after users log off from ICA 
sessions. Saving printed jobs can use a lot of space.

Delete pending print jobs at logout. Select this option to delete pending print jobs 
when a user logs off. Do not select this option if you want users to see print jobs 
from prior ICA sessions when they log on.

Always create client network printers as client printers. Select this option if you want 
the client device and not the MetaFrame Presentation Server to process printing 
requests. When you select this option, communication from MetaFrame 
Presentation Servers to client devices is faster when they talk across a WAN. Data 
sent to the client is compressed, so less bandwidth is consumed as the data travels 
across the WAN. Additionally, if two network printers have the same name, the 
printer on the same network as the client is used.

You can specify which printers are auto created by selecting one of the following 
options:

Default client printer only. Select this option to auto create only the default printer on 
each client device.

Local (non-network) client printers only. Select this option to auto create only the 
local client printers on a user’s client device. Local client printers are connected 
directly to the client device through an LPT, COM, USB, or other local port.
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All client printers. Select this option to auto create all of the client printers on a 
user’s client device.

Use connection settings for each server. Select this option to accept the settings 
specified for the ICA connection in the Citrix Connection Configuration utility. 
This option is selected by default. 

The term connection refers to the virtual ports that are associated with network 
protocols on servers running MetaFrame Presentation Server.

Network printers assigned to users can be updated when users log on.

Auto Creation and Citrix Connection Configuration
Settings that affect auto creation of client printers appear in Citrix Connection 
Configuration. An overview of these settings is included here. For more 
information about these settings, see the online help for Citrix Connection 
Configuration. For specific information about client capabilities and settings, see 
the client administrator’s guide for each client platform. Client administrator’s 
guides are available from the Document Center.

To change the connection configuration

1. Launch Citrix Connection Configuration by opening Start > Programs > 
Citrix > MetaFrame Presentation Server > Citrix Connection 
Configuration.

2. Double-click the connection in the Citrix Connection Configuration window, 
and click Client Settings. 

If the Connect Client Printers at Logon option is selected in the connection 
properties or user profile, client printers are automatically created when users log 
on to ICA sessions. MetaFrame Presentation Server deletes the printers when users 
log off if the printers do not contain unfinished print jobs. Changes made by users to 
their Windows printer settings are not maintained. If print jobs are present, 
MetaFrame Presentation Server retains the printer and its associated jobs.

If a user’s connection profiles do not specify Connect Client Printers at Logon, the 
user can connect to a client printer through Windows printer setup. MetaFrame 
Presentation Server does not automatically delete printers that are set up this way 
when users log off.
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Using the Universal Printing Capabilities
As described previously in this chapter, MetaFrame Presentation Server 
automatically creates client printers when users log on to MetaFrame Presentation 
Server. With auto creation of client printers, users print to their regular printers from 
applications that are running on MetaFrame Presentation Servers without having to 
set up their printers each time they log on.

Auto creation of client printers requires drivers for client printers to be available on 
the servers. The driver replication feature helps ease printer driver management. 
However, maintaining drivers for many different printing devices can cause 
problems.

Universal printing is designed to avoid problems with driver maintenance and other 
client printing issues in diverse environments.

Client Printing with the Universal Driver
The universal printing feature works as follows:

• A single generic printer driver is used on the server to prepare print jobs. This 
can be the universal driver for the PostScript (PS) language or the PCL5c or 
PCL4 variations of the Printer Control Language.

• The generic driver creates a print data stream, spools the print job, and redirects 
the job to the ICA client.

• The client printer renders the print data stream again using a PCL4, PCL5c, or a 
PS interpreter.

• The client device’s local printer drivers are used to create print images that can 
be directed to any printer connected and configured on the client device. Print 
jobs are not restricted to PCL or PostScript compatible printers.

With generic printer drivers you do not need to install and duplicate a potentially 
large set of native printer drivers throughout the server farm. You may need to 
deploy a few specific printer drivers for applications that require options not 
provided by a universal driver.

You can view the properties of a client printer created with a universal print driver 
to see the options that are available. A tag in the format [UPD:PCL5c] is appended 
to the name of a printer created using a universal printer driver.

Which universal driver a client can work with depends on the client device’s 
version and platform. The application server can determine the highest level of 
universal driver with which the client is compatible. The server uses that universal 
driver to create a client printer within the ICA session. The server can then use the 
universal driver to send print jobs to that client printer. The client printer translates 
the print data streams into print images for specific devices.
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By default, the auto creation process uses the native printer driver for a specific 
printer on the client device to create the client printer. If the correct native printer 
driver is not available on the application server, the client printer is automatically 
created using a compatible universal driver. You can use the Presentation Server 
Console to change the default settings. Select Printers or Drivers in the left pane of 
the Printer Management Properties page to change settings for client printer auto-
creation.

To view the universal printer drivers installed on a selected server

1. Select the server in the left pane

2. Click the Printer Drivers tab.

Benefits of Using the Universal Driver 
With universal printing, you can avoid the following issues:

• Some native printer drivers, especially those that do not use an advanced page 
description language such as PCL or PostScript, generate very large print files. 
These files can cause unacceptable delays when print jobs are spooled from the 
server to the client over a WAN or other slow connection.

• Many printer drivers are not well tested in a terminal server environment. Some 
drivers cause frequent fatal system errors and spooler faults. Installing many 
printer drivers for a large user base can destabilize servers.

• Although driver maintenance is more convenient with MetaFrame Presentation 
Server, the effort required to obtain, install, and manage many different printer 
drivers for a diverse environment can be substantial. Even with careful 
maintenance, drivers required for printing to every device might not be installed 
in the server farm. Missing drivers prevent auto creation of client printers for 
users.

To configure printing options for the server farm

1. In the Presentation Server Console, right-click Printer Management and 
choose Properties. The options let you control the automatic creation of client 
printers and the use of printer drivers. For more details about using the options 
available for the Universal Printer Driver, see the console help.

2. When you have finished configuring the printer properties, click OK.
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Using Policies
To apply selected MetaFrame Presentation Server settings to specific Windows 
domain users or user groups, you create and apply user-based policies. For 
example, by creating and applying user-based policies you can:

• Allow users to shadow other users’ client sessions

• Control access to drives, ports, and printers on client devices

• Set a required encryption level for client sessions

• Turn off Client Auto Update for specific users

With user policies, you can tailor MetaFrame Presentation Server to meet users’ 
needs based on their job functions, geographic locations, or connection types (LAN, 
WAN, or dial-up). For example, for security reasons, you may place restrictions on 
user groups who regularly work with highly sensitive data. You can create a policy 
that requires a high level of encryption for ICA sessions and prevents users from 
saving sensitive files on their local client drives.

Creating a Policy
In the following procedure, the example assumes that you want to create a policy 
for your “Sales” user group that allows them to shadow the department manager. 
The sales department uses the user shadowing feature for online collaboration on 
sales leads.

To create a policy for shadowing

1. In the left pane of the Presentation Server Console, select Policies.

2. From the Actions menu, choose Policy > Create Policy.

3. In New Policy, for Policy Name, enter Shadow, then click OK.

4. In the right pane, double-click Shadow.

5. In the left pane of Shadow Properties, expand User Workspace > Shadowing, 
then click Configuration.

6. In the right pane, select Enabled and Allow Shadowing.
If, for example, the sales manager works with sensitive data, select Prohibit 
being shadowed without notification. If the sales manager does not want other 
users to be able to take control of his mouse and keyboard, select Prohibit 
remote input when being shadowed.

7. In the left pane, select Permissions.

8. In the right pane, select Enabled, then click Configure.
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9. In Assign Shadowing Permissions, double-click your domain, choose Domain 
Users, click Add, then click OK.

10. In Shadow Properties, click OK.

After you have created the Shadow policy and configured its rules, assign the policy 
to connections that you want to be able to shadow.

Assigning a Policy
To assign the shadowing policy to connections

1. In the right pane, right-click Shadow and select Apply this policy to.

2. In Shadow Policy Filters, in the left pane, click Users.

3. In the right pane:

• Select Filter based on users.

• Double-click your domain, select Domain Users, then click Add.

4. Click OK.
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CHAPTER  4

Using MetaFrame Access 
Suite Components

This chapter introduces the MetaFrame Access Suite Console and describes:

• Configuring Access Suite Console for the First Time

• Accessing Farm Information

• Accessing Access Suite License Server

• Using the License Management Console
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This screen capture shows the Access Suite Console before running discovery and with 
the MetaFrame Access Suite node expanded.

Configuring Access Suite Console for the First Time
In order to connect Access Suite Console to installed MetaFrame Access Suite 
products, run the discovery process.

To run discovery

1. On your primary server, open the MetaFrame Access Suite Console by 
choosing Start > All Programs > Citrix > Access Suite Console.

2. In the left pane of Access Suite Console, choose MetaFrame Access Suite, 
then, under Common Tasks, click Run discovery.

3. In Run Discovery, click Add Local Computer, then click OK.

4. In Discovery completed, click Close.

Note that you can now monitor and administer DemoFarm and its servers from 
MetaFrame Access Suite Console.
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Accessing Farm Information
You can use the Access Suite Management Console to access information 
concerning DemoFarm.

To access information about DemoFarm

1. In the left pane of MetaFrame Access Suite Console, expand DemoFarm and 
note folders for Applications, Servers, and Zones.

2. Expand the Applications node and note the applications you published: 
Calculator2, My Citrix, Notepad1, and Shadow. To view information about a 
published application, click it.

3. Expand the Servers node and note the listing of the two servers that make 
up DemoFarm. Select the primary server, and in the right pane, use the pull-
down menu to view information about the server.

4. Expand the Zones node and click your zone. Note that Data Collector is part of 
the information displayed about the zone. The data collector is the database that 
stores dynamic information about a zone.

In addition to monitoring a server farm, you can also use the Access Suite Console 
to access the Access Suite License Server.

Accessing the Access Suite License Server
You can use the MetaFrame Access Suite Console to access license servers and 
manage licenses. To manage licenses, follow the instructions in the this section.

Adding a Shortcut to Access Suite License Server
In order to connect to the License Management Console, add a shortcut to the 
Access Suite License Server.

To add a shortcut to the license server

1. In the left frame of Access Suite Console, choose Licensing, then click Add 
shortcut to license server.

2. In Add a link to a License Management Console, for Server, type the computer 
name of your license server, which is your primary server, then click OK.
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Launching License Management Console
After adding a shortcut to the License Management Console, you can open it and 
manage licenses.

To launch the License Management Console

1. In Shortcuts to license servers, select the license server in the list.

2. Click Launch License Management Console on server.

3. Enter your credentials, then click OK.

4. Close the License Management Console.

For more information on using the License Management Console, continue with the 
next section.

Using the License Management Console
The License Management Console lets you manage and monitor your Citrix 
licenses by providing a user interface to the license server. You can download 
licenses, display real-time inventories of licenses, run historical usage reports, and 
monitor alerts with the console. Use the console to configure and maintain the 
license server. Because the console displays in a Web browser, you can manage 
licenses from any location on your network. You can also connect to the License 
Management Console remotely over a secure http connection.

This diagram shows three workstations with access to the Licenses Management 
Console, which resides with the license server on a single computer.
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You can manage only the license server on which the License Management Console 
is running. 

The four functions you can manage with the console are 

• Displaying your license inventory

• Running reports that detail past license use

• Configuring the license server and the License Management Console

• Assigning permissions to the License Management Console by user or user role

All of these tasks are explained in the sections that follow. For more information, 
see the License Management Console online help.

Opening the License Management Console
You can run the License Management Console using Internet Explorer 5.01 or 
greater, or Netscape 4.7 and greater. To access the License Management Console, 
navigate to the server on which the License Management Console is running.

To open the License Management Console on your primary server

1. Using the user name you used when you installed the license server, log onto 
your primary MetaFrame Presentation Server, which is also where you installed 
your license server.

2. From the Start menu, choose All Programs > Citrix > Management Consoles 
> License Management Console.

To open the License Management Console from your client computer

1. Using the user name you used when you installed the license server, log onto 
your client computer.

2. Using a Web browser, open the following link:
http://servername/lmc/index.jsp

where servername is the name of the computer running the license server.

3. In the Welcome page of License Management Console, click View Current 
Usage Data.
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Determining License Availability
The Current Usage page lets you see the number of licenses you have installed, the 
number of licenses that are in use, and the number of licenses that are available for 
use and their availability as a percentage of the total number of licenses.

The Current Usage page displays system, license expiration, license usage, and 
Subscription Advantage alerts. By clicking the red icon that appears beside the alert 
number, you can see details about the alerts, such as the product name, license 
model, license type, version date, expiration date, the number of licenses installed, 
and the number of licenses in overdraft. 

You can adjust when alerts appear by changing your threshold options. The 
Threshold Options page, which is available from the Configuration page, lets you 
set the values that represent warning and critical levels. Each type of alert, license 
usage, Subscription Advantage renewal date, and expiration date, all have different 
thresholds that you can set. The threshold is the value that must be met to raise 
an alert. 

All three types of alerts let you set both warning and critical alert levels. In the case 
of Subscription Advantage and expiration date alerts, the levels indicate the number 
of days remaining before expiration. For example, if you put 120 as the number of 
days remaining before the expiration date, the License Management Console will 
show an alert on the 120th day before your product’s license expires. For license 
usage, alerts are raised when the percentage you set as a warning or a critical alert 
threshold is met.

Perusing Historical Usage
Historical reports are based on log files, the encoded record of license usage 
generated by the license server. By running historical usage reports, you can choose 
to see license availability and consumption information for one or more log files. 
The License Management Console lets you choose the type of product, date range, 
summary period, and data type you want to use in the report. The term summary 
period refers to the time period for which you want to generate a report. The term 
data type refers to the units in which the data is measured; data can be measured in 
hours, as a percentage, or as a quantity.

You can also change the appearance of the reports by changing the font they appear 
in, the line weight, and the report color scheme. 
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Controlling License Management Console Access
For administrators to have access to the License Management Console, you must 
create user accounts for them. When you install the console, a user account with full 
permissions is created for you automatically based on the credentials you used to 
log on to the license server during installation. The console is designed for anyone 
who is administering Citrix licensing as well as people who need to run licensing 
reports. Because you might not want all users to have access to all features of the 
License Management Console, you can specify permissions on an account-by-
account basis. After you create a user account, you can set user permissions for the 
four major areas of the console: current usage, historical reporting, configuration, 
and user administration. 

When you create a user account, you must create a user name. You must preface the 
user name with the domain to which the user belongs. License 
Management Console user names have the same restrictions as those in your server 
operating system. The password for the License Management Console is the same 
as the user’s domain password. 

The User Access page on the User Administration tab lets you control not only 
what tasks console users can perform but also what features they can see in the 
License Management Console. However, at least one administrator must have full 
access to the License Management Console at all times.
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Using Load Manager

With Load Manager, an administrator can set up, monitor, and adjust server and 
published application loads in a server farm so that users can run the applications 
they need quickly and efficiently.

When a user connects to a published application that is load balanced with Load 
Manager, Load Manager identifies the server with the lightest load for that 
application. The user is not aware of load balancing; load calculations are not 
communicated to the user in any way.

You manage and monitor server and user loads using Presentation Server Console. 
You can set unique methods for calculating server loads by adjusting the rules 
settings in load evaluators.
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Introducing Load Manager Rules
Administrator-defined rules provide the framework to determine server load. For 
example, you can set the rule called server user load to be considered full at 100 
users. When this limit is reached, the server is not available for additional 
connections.

The rules included in Load Manager are:

• Application user load

• Context switches

• CPU utilization

• Disk data I/O

• Disk operations

• IP range

• Memory usage

• Page faults

• Page swaps

• Scheduling

• Server user load

Load evaluators are made up of one or more rules and their load settings. You 
create load evaluators to perform customized load management tasks and then 
attach them to servers. You can create as many load evaluators as you need for 
optimum server or published application performance. However, each server can 
have only one load evaluator attached to it. Load evaluators can vary on each 
server, and each load evaluator can contain any combination of rule types and 
values.

Working With Load Evaluators
The Default and Advanced load evaluators are predefined evaluators that cannot be 
modified. The Default load evaluator contains one rule—server user load—that 
reports a full load when 100 users log on to the server. The Default load evaluator is 
attached to your server by default when you activate your Advanced or Enterprise 
Edition license, enabling Load Manager. You can create new load evaluators for 
your specific needs.
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To create a load evaluator

1. In the in the left-hand pane of the Presentation Server console, select 
Load Evaluators.

2. In the right pane, right-click Advanced and choose Duplicate Load Evaluator.

3. In Duplicate Load Evaluator, for Name type Demo Evaluator.

4. In Available Rules, choose Application User Load, and click Add.

5. For report load, replace 100 with 1.

6. For Application, choose Notepad1.

7. In Assigned Rules, choose CPU Utilization.

8. For report load, replace 90 with 70.

9. In Assigned Rules, choose Memory Usage.

10. For report load, replace 90 with 60.

11. In Assigned Rules, choose Page Swaps and click Remove.

12. Click OK.

To assign a load evaluator to an application

1. In the in the left pane, expand Applications, right-click Notepad1, and choose 
Load Manage Application.

2. In Load Manage Application:

• Click Add All.

• Under Available Load Evaluators, click Demo Evaluator, click Apply, 
then click OK.
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Viewing Load Evaluator Assignments
Load Manager gives you three ways to view your load-balancing framework.

To view information about the load evaluators in use

1. In the management console, select the Load Evaluators node in the left-hand 
pane.

2. Click the Usage Reports tab in the right-hand pane. You can view these reports 
by server, by application, and by evaluator. The following example displays the 
usage reports by evaluator.

Monitoring Server Loads
The Load Manager Monitor too checks recent loads using a graph format. The 
evaluator loads continuously change, based on the rules you set in your load 
evaluators and the level of load activity.

Important To view the server loads, connect to one or more published applications 
using at least one client device.

To view the load for a server

1. From your client device, run the Notepad published application using Program 
Neighborhood Agent.

2. In the left-hand pane of the console on your primary server, select the server you 
want to monitor.

3. Click the Load Manager Monitor tab in the right-hand pane. A yellow line 
indicates the status of each rule in real time.

Note For the purposes of this evaluation, a single connection does not result in a 
representative graph.
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Using Resource Manager

Resource Manager enables administrators to efficiently manage and monitor 
MetaFrame Presentation Server farm resources to ensure optimum application 
availability and performance for users.

This section contains the following information about Resource Manager:

• Understanding the Report Center

• Delegated administration

• Identifying status icons

• Monitoring servers

• Customizing real-time monitoring

• Monitoring the status of a group of servers

• Using the summary database

• Creating reports
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Report Center
The Report Center is one of the system management tools provided through the 
Access Suite Console. The Access Suite Console snaps into the Microsoft 
Management Console to provide a central location for system management tools. 
You can also use it to launch other consoles such as the MetaFrame Presentation 
Server Console.

The Report Center extends Resource Manager reporting capabilities, and allows 
you to easily generate reports from a variety of real-time and historical data sources. 
A wizard helps you select the type of report, the data to be displayed, and the 
schedule for running the report. You can view the status of your scheduled report, 
and, for those that have not been run, you can adjust the report parameters.

Report Types
The Report Center contains several report types, for example:

• Application Availability report. Lists the published applications in a farm and 
the percentage of time when they were available, in a planned down state, and in 
an unplanned down state.

• Server Availability report. Lists the servers in a farm and the percentage of 
time when they were available, in a planned down state, and in an unplanned 
down state.

• Server Performance report. Displays, for the selected servers, the average 
CPU utilization, the minimum memory available, and the maximum number of 
concurrent connections. The report also contains details of the most heavily 
loaded servers.

• Application report. Provides details of all published applications including the 
servers they are published on, users and groups with access to them, and any 
options used by clients that connect to the applications.

• Application Usage report. Shows the most frequently used applications, the 
number of times each application has been accessed, and the maximum number 
of concurrent users.
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Real-Time Monitoring Capabilities
The Dashboard on the Access Suite Console allows you to display performance 
metrics for the servers in a farm in a highly visual way. 

You can create custom views of farms, zones, servers, and applications by using the 
My Views feature. My Views allows you to create and save customized views of 
items in your deployment. You can then see updated information about those items 
at any time, without having to search for them. For example, you can group related 
objects in folders or you can order farms, according to the frequency with which 
you need to access them. 

You may want to monitor farms located in different locations. In this case, you 
could use the My Views feature to create a custom view that groups each farm in a 
different part of the screen and then use a background graphic to identify each 
location. A suitable performance metric, such as CPU Load, displayed in your 
custom view, allows you to pinpoint problems quickly on any server in any 
location. 

Using custom views in this way helps you anticipate or identify problems with your 
servers or applications as soon as possible. Note that these servers must be running 
the MetaFrame Presentation Server Provider for Microsoft Windows Management 
Instrumentation.

For more information about the Access Suite Console, see “Using MetaFrame 
Access Suite Components” on page 71.

Delegated Administration
Enhanced delegated administration in Resource Manager allows you to delegate the 
tasks of controlling applications and analyzing system and application data to 
custom administrators. For more information on Enhanced Delegated 
Administration, see the MetaFrame Presentation Server Administrator’s Guide.

To simplify the configuration of custom administrators, full administrators may find 
it easier to first create a suitable folder hierarchy, and then create custom 
administrators with the necessary permissions. You create custom administrators 
using the Add MetaFrame Administrator wizard in the Presentation Server 
Console. 

For Resource Manager you can:

• Delegate the control of Resource Manager applications to custom 
administrators. A Resource Manager application is an application that is not a 
MetaFrame Presentation Server published application but is still recognized 
by the Resource Manager system. Details of how to set up Resource Manager 
applications are provided in the Help.

Download from Www.Somanuals.com. All Manuals Search And Download.



86 MetaFrame Presentation Server Reviewer’s Guide

• Determine which custom administrators can generate current reports, summary 
reports, or Billing reports

• Ensure that administrators receive alerts only for those servers for which they 
have responsibility

Identifying Status Icons
For each server in your system, colored status icons (visual alarms) show the status 
of each monitored condition or metric.

During installation, Resource Manager automatically configures a set of limits for 
the metrics that apply to each server. If the value of a metric falls outside normal 
limits, a visual alarm is displayed to warn you. You may be required to alter these 
limits to suit your specific MetaFrame Presentation Server environment.

The following table describes the meaning of each condition:

Resource Manager determines the status of each alarm condition by sampling the 
statistics associated with the monitored condition every 15 seconds, and the colored 
Status Icons change accordingly.

Represents normal operation where the value of a metric falls within set limits.

Represents a warning where a problem may be developing that requires further analysis to 
improve performance or to prevent the situation from becoming worse.

Represents a problem condition. This often means that some action is required to provide better 
application or server performance.
Both yellow and red indicators occur when the value for a metric falls outside the normal limits 
and remains there for a defined period of time.

Represents a metric that is not yet active and requires further configuration

Represents a metric that is set to “Sleep” and whose status is “unknown.” This icon is also used 
(for all metrics) if the server is unlicensed.

Represents a metric that is set to “Idle”; that is, you have suspended notification of the metric’s 
status for a fixed period.
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Monitoring Servers
There are a number of ways in which Resource Manager enables you to monitor the 
status of servers in your server farm. You can monitor the status of individual 
servers, of all selected servers, or display a window that enables you to watch for 
alarms when the status displays are not visible.

To view the status display for a server

1. In the left pane of the Presentation Server Console, expand the Servers folder, 
then click the server you want to examine. To view the status of all servers, click 
the Servers folder.

2. To display the current set of metrics that are being monitored for the server, 
click the Resource Manager tab.

When a metric’s value goes beyond its defined limits, Resource Manager displays 
an alarm status icon for the metric.

When the status display for all servers in your system is not visible, you can 
monitor any problems that occur by displaying the Resource Manager Watcher 
tab.

To display the Resource Manager Watcher tab

1. Select Resource Manager in the left pane of the console and select the 
Watcher tab. Alternatively, click the button on the management console 
toolbar.
This window lists any servers that have red or yellow alarms.

2. Double-click a server alarm to view the status display for that server.

Customizing Real-Time Monitoring
By changing the set of metrics that is being monitored, or altering the alarm 
configuration for specific metrics on each server, you can tailor real-time 
monitoring to suit your network environment.

To change the set of metrics being monitored

1. In the left pane of the management console, click a server or published 
application.

2. Click the Resource Manager tab in the right pane.

3. Right-click one of the listed metrics and select Add/Remove Metrics.

As indicated in the Add/Remove Metrics dialog box, a metric is a combination of 
three items:
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• Object. The category that you want to monitor. It is a physical or logical system 
resource; for example, a computer's hard disk.

• Counter. The counter to be monitored. This is the specific aspect of the object 
that you want to monitor; for example, disk free space.

• Instance. The instance of the object. An individual example of the object or a 
state it needs to reach in order to be counted. For example, a computer may have 
more than one hard disk. In this case, the instance identifies which disk you 
want to examine.

For the purposes of this evaluation, do not change the default set of metrics.

To change the metric properties

1. In the right pane of the management console, right-click any metric.

2. Click Properties.

3. In the Server Metric Properties dialog box, you can configure how alarms 
should operate for each metric by:

• Specifying the thresholds for each alarm type using the Yellow Limit and 
Red Limit columns.

• Specifying the time period beyond which a limit must be exceeded to trigger 
an alarm using the Yellow Time and Red Time columns.

Tip To help you set appropriate thresholds for a new metric that is not yet 
configured (blue status indicator), you can display a graph of the current metric 
value and set the Yellow and Red Limits to levels that suit these values. Click any 
metric, then click Visual Threshold Configuration.

Monitoring the Status of a Group of Servers
You can monitor a group of servers as an individual unit by placing them into a 
folder and viewing the status display for that folder.

To monitor a selected group of servers

1. Right-click the Servers folder in the left pane, and select New Folder.

2. Enter a name for the new folder in the text box.

3. Select server names from the left pane, and drag and drop them into the new 
folder.

4. Select the new folder and click the Resource Manager tab to view the status 
display for all servers in the customized unit.
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Using the Summary Database
Resource Manager can now store process, event, and any Resource Manager metric 
information you select in an external Microsoft SQL Server or Oracle Database 
DBMS. You can use a summary database to retrieve historical records or generate 
reports. You can also generate reports from a summary database using an external 
package such as Crystal Reports.

Before you start using a summary database

1. Install your DBMS software onto a server and create a database on it. Resource 
Manager supports the following DBMS software:

• Microsoft SQL Server Versions 7 and 2000

• Microsoft Access and SQL Server 2000 Desktop Engine (MSDE)

• Oracle Database Versions 7, 8i, and 9i.

2. Set a system data source name (DSN) to communicate with the summary 
database DBMS.

3. Configure a Database Connection Server. This server enables communications 
between the server farm and the summary database by writing data to the 
database and reading data from it. It should be relatively low-load for best 
performance.

Creating Reports
Resource Manager enables you to produce a variety of reports based on the 
information stored locally on each server, known as Current reports, or from the 
information in your summary database, known as Summary reports. The major 
differences between the two report types are:

• Current: These reports are generated from Resource Manager information 
stored in the local database on each server and can be generated on a per-server 
basis. The information is recorded at 15 second intervals and is referred to as 
real-time. The Server Snapshot report can be stepped back to any time within 
the last 96 hours.

• Summary: These reports are generated from Resource Manager summary data 
stored in the summary database and can be generated for multiple servers. 
Summary reports are less detailed than Current reports; however, they provide a 
much greater historical scope and can be stepped back through any available 
summary data. Summary reports can be customized to include or exclude 
various record types.
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You can use the information from Resource Manager reports to inform others about 
the MetaFrame Presentation Server environment and to establish future resource 
requirements. You can identify why problems occur, and reduce the likelihood of 
these occurrences in the future. You can also examine server, user, and process 
activity trends, and statistics to help you better maintain your server farm.

Note Resource Manager uses a number of HTML templates to create reports. 
These are located on each server in the Templates subfolder of the Citrix Resource 
Manager folder. To avoid inconsistencies in the reports, do not edit the templates.

If your number format settings use commas as decimal separators, Resource 
Manager replaces them with semicolons (;) when saving reports to CSV format, 
because commas are used specifically in this format to separate the items of data in 
the file.

To generate a report

In the left pane of the management console, click Resource Manager, then click 
the Reports tab.

Looking Back to a Specific Time
If there is a problem on a particular server, you can produce a report of its status, 
generated for a 15 second period, at the time the problem occurred. You can then 
use this report to evaluate why the problem happened.

To produce a Server Snapshot report

1. Click Server Snapshot.

2. Select the server you want to report on, and the period to report on. The Server 
Time box shows the current local time for the selected server.

3. Click Generate to create the report and view it.

You can generate further Server Snapshot reports on the same server, stepped by 15 
seconds each time, by clicking the Step 15 seconds arrow buttons in the report 
viewer window. You might want to do this, for example, to pinpoint the cause of a 
server problem. Each time you step the report, a new report is generated and 
displayed in the right hand pane of the window, with the report date and time for it 
displayed in the Report List in the left hand pane. Clicking a report in the Report 
List displays that report in the right hand pane.

See the Resource Manager online help for instructions about generating and 
interpreting Resource Manager Current reports.

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 6 Using Resource Manager 91

Reporting on the Use of Applications
You can produce a report that displays information about the processes that are 
being monitored in the server farm, and in particular, processes that are running on 
a specific server.

To produce a recent process report

1. On the Reports tab, click Current Process.

2. Choose the process and user on which to report and use Report Options to 
specify the information that you want to include in the report.

3. Click Generate. The report displays in a separate window.

4. To save a copy of the report, from the File menu, choose Save as HTML or 
Save as CSV.

5. When you are finished, click Cancel.

Reporting User Activity
You can use Resource Manager to provide information about how users at your site 
use applications and servers.

To display a user’s analysis report

1. On the Reports tab, click Current User.

2. For server, choose your secondary server and for User, choose All Users, then 
click Generate.

3. To save a copy of the report, from the File menu, choose Save as HTML or 
Save as CSV.

4. When you are finished, click Cancel.

Viewing Saved Reports
You can view reports that are saved as HTML files and if required, you can convert 
them to CSV format.

To view a saved report

1. On the Reports tab, click View Saved Report.

2. Navigate to the location of the report and click Open.

3. When you are finished, click Cancel.

This concludes the demonstration of MetaFrame Presentation Server.
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A P P E N D I X

Frequently Asked Questions 

The online Knowledge Base contains an extensive collection of application notes, 
technical articles, troubleshooting tips, and white papers. The Knowledge Base is 
available in the Support area of the Citrix Web site: http://www.citrix.com.

Why did Citrix create different editions of MetaFrame Presentation Server solutions?
Citrix created different editions of MetaFrame Presentation Server, based on 
extensive customer and partner feedback, to accommodate application-serving 
environments of all sizes. By integrating advanced management capabilities into 
MetaFrame Presentation Server, customers can more easily take advantage of the 
significant return on investment (ROI) and e-Business enabling benefits of Citrix 
load management, system monitoring and analysis, application packaging and 
delivery, and integrated network management capabilities.

What is Citrix MetaFrame Presentation Server for Windows, version 3.0?
Citrix MetaFrame Presentation Server is the easiest way to manage enterprise 
applications from a central location and access them from anywhere. 

• Access any application on any device. 

• Web-enable existing applications.

• Simplify applications deployment.

• Easily manage server farms from a single interface. 

• Leverage and extend existing investments in hardware and software. 

New features and functions are designed to add maximum value to your Windows 
server family investments without the typical complexity associated with migrating 
to a new architecture or platform.
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What Microsoft Windows server platforms support MetaFrame Presentation Server for 
Windows, version 3.0?
MetaFrame Presentation Server is optimized for Microsoft’s advanced Windows platform 
and operates on the following platforms:

• Microsoft Windows 2000 Server

• Windows 2000 Advanced Server

• Windows 2000 Datacenter Server

• Windows Server 2003

MetaFrame Presentation Server is not supported on Windows NT 4.0, Terminal Services 
edition.

Does MetaFrame Presentation Server for Windows, version 3.0, support Microsoft Windows 
Server 2003?
All editions of MetaFrame Presentation Server, version 3.0—Enterprise, Advanced, and 
Standard editions—run on Microsoft’s latest version of the Windows server operating 
system. All MetaFrame Presentation Server components, such as the Management Console 
for Access Suite, the Management Console for MetaFrame Presentation Server, Resource 
Manager, Network Manager, Installation Manager, Web Interface, Secure Gateway, and 
Document Center, run on Windows Server 2003.

Will MetaFrame Presentation Server work with members of MetaFrame XP product family?
Yes. Feature MetaFrame Presentation Server, version 3.0, operates with all three members of 
the MetaFrame XP product family—MetaFrame XPs, XPa, and XPe. However, not all 
features are designed to work on all three solutions in the MetaFrame XP family. Activation 
of specific features is contingent on the MetaFrame XP solution used in conjunction with 
MetaFrame Presentation Server 3.0.

What international languages does MetaFrame Presentation Server for Window, version 3.0 
support?
MetaFrame Presentation Server for Windows is available in English, German, Japanese, 
French and Spanish.

What components are included in MetaFrame Presentation Server for Windows, version 3.0?
This release contains the following components:

• MetaFrame Presentation Server

• MetaFrame Presentation Server Console

• MetaFrame Clients

• The Web interface

• Extensible solutions

• Secure gateway 2.0
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If I am using MetaFrame XP, will I have to reinstall the entire product in order to get the 
functionality in MetaFrame Presentation Server 3.0?
No. Only the components needed to update your MetaFrame Presentation Server to 3.0 will 
be installed. There is no need to reinstall MetaFrame Presentation Server or any applications 
on the server. All prior settings will remain unchanged as a result of installing MetaFrame 
Presentation Server 3.0.

Does MetaFrame Presentation Server 3.0 have strong encryption technology?
Yes. MetaFrame Presentation Server 3.0 contains Transport Layer Security (TLS) and 
Secure Sockets Layer (SSL) encryption technologies at the 128-bit encryption level.

Is MetaFrame Presentation Server 3.0 available for import into all countries where Citrix does 
business?
Restrictions on importing strong encryption technology (128-bit encryption or greater) vary 
by country. For more information on whether MetaFrame Presentation Server 3.0 for 
Windows is allowed to be imported into your country, please contact your local member of 
the Citrix Solutions Network.

Will existing clients work with MetaFrame Presentation Server?
Yes. Clients are both forward and backwards compatible and work with MetaFrame 
Presentation Server 3.0 and prior versions. However, as Citrix adds new client-based 
features, some features will be available only by using the latest clients. Thus, Citrix 
recommends that MetaFrame Presentation Server customers use the latest clients at all 
times. The latest clients are available at http://www.citrix.com/download
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